
FastTrack
The Music Industry's Most Powerful Database!

Thanks for trying FastTrack!    We hope you will find it to be a useful 
program, whether you are trying to get a band off the ground or give your 
business a little boost.    The valuable information contained in FastTrack 
should be just what you need to give you an edge in the competitive 
music business.

If you like FastTrack, please register it!    The registered version contains 
the full database of over 3500 music industry names, addresses, and 
phone numbers.    See Registration on the Help menu for details on how 
to register this software.

While we have made every effort to compile the most complete, up-to-
date information possible, things in the music industry change fast.    
Some of the businesses listed in the database may have gone out of 
business or changed ownership by the time you receive your copy of 
FastTrack.    Therefore, we can make no claims or guarantees regarding 
the accuracy of the information in the FastTrack database.

For more information, choose one of the following topics:
Introduction to   FastTrack  
Menus



Introduction to FastTrack

FastTrack is a powerful database designed specifically for the music 
industry.    With one simple-to-use tool, you can gain access to thousands 
of valuable names, addresses, and phone numbers.    FastTrack contains 
the most complete database of music industry addresses ever released.    
It contains bands, booking agents, concert promoters, radio stations, 
record companies and much more.

Using FastTrack does not require any knowledge of complex database 
concepts.    Words like Query and Criteria are not used here.    Instead, the 
user is guided step-by-step through a search process to find the 
information he or she needs.    When the desired information has been 
specified, FastTrack will copy the information to the Windows clipboard 
for use in any Windows application.    For example, you could copy the 
addresses into a Word for Windows document and use them for a mailing 
list.    Alternatively, you could copy them into a spreadsheet like Excel and 
create a phone list.    The combination of a vast database and a simple 
user interface makes FastTrack the most valuable tool for established 
and up-and-coming businesses.

For more information, see the following topic:
Conducting a Search



Menus

By using FastTracks pull-down menus, you can perform searches through
the database, add information to the database, and modify information in 
the database.

For more information, choose one of the following topics:
File Menu
Edit Menu



File Menu

The File menu contains a number of options which allow you to create 
new searches through the FastTrack database and saving these searches
for future use.    Choose one of the following topics for more information.

For more information, choose one of the following topics:
New Search
Open Saved Search
Save Search



Edit Menu

The Edit Menu contains two options which allow you to alter the contents 
of the FastTrack database.    Choose one of the following topics for more 
information.

For more information, choose one of the following topics:
Add/Change Database Items
Setting FastTrack Options 



File Menu:    New Search

Select New Search when you want to begin a new search for information 
from the FastTrack database.    This will cause the Business Types panel
to pop up.

For more information, see the following topic:
Conducting a Search



File Menu:    Open Saved Search

When you wish to reuse a search you have previously constructed and 
saved, choose File | Open Saved Search to load the search file.    When 
you choose this menu item, a file browser will be opened.    This allows 
you to specify the name of the search file.

FastTrack search files typically have the file extension .fts.    Therefore, 
the file browser usually looks for files of this type.    However, you can 
change the type of file for which it will search by changing the contents of
the File Name text box.    For example, to search for all files ending 
in .txt, click in the text box, delete the characters there, and type:

*.txt

When you have selected the search file which you want to load, press the 
OK button on the file browser or Cancel to abort without loading a search
file.    If you press the OK button, FastTrack will load the search file, 
execute the search, and present you with a panel telling you how many 
recordswere copied to the clipboard.



File Menu:    Save Search

When you have successfully completed a search, you may have spent 
quite a bit of time constructing the search.    You may find sometime that 
you will want to use the same search again.    FastTrack allows you to 
save your search for future use.

Choosing File | Save Search will open up a file browser.    Use this 
browser to specify the name of your search file.    If you do not specify a 
filename extension for your search file, FastTrack will give it the 
extension .fts.    When you have specified the file name, press the OK 
button on the file browser to save your search or Cancel to abort without 
saving your search.

To use a search later, use Open Saved Search.



Edit Menu:    Add/Change Database Items

This menu option pulls up the Edit/Add panel.    With this panel, you can 
add new businesses to the FastTrack database, change information 
about existing businesses, or delete businesses from the database.    

To add a new business, press the NEW button.    Then simply fill in the 
information about the new business, and when you are done, press SAVE 
(you can also press NEW to enter another new business).    Before saving 
the data, FastTrack will do a quick check to make sure that your new 
business is a valid one by checking the following things.

Business Type - you must specify a valid business type for 
every new business.

Music Types - you must have specified at least one music type
for your new business.

State Abbreviations - if you have entered a state abbreviation,
FastTrack will verify it.

These checks help you to enter more accurate data.    At the same time, 
they are flexible enough to allow you to enter businesses for which you 
have incomplete data.    For example, you dont have to have a business 
address, but if you do enter a state for the business, FastTrack will make 
sure that you entered a valid state.

It is crucial that every business have a valid business type and at least 
one music type specified.    Otherwise, you would never be able to access 
that business information through a search, so it would be of no use to 
you.

For convenience in entering a large number of businesses, once you have 
selected a business type and a music type, these values remain constant 
across entries.    They will not change unless you modify them.    So if you 
want to enter 100 radio stations, for example, you can select Radio 
Stations when you enter the first station, and you wont have to touch this 
control for the other 99 entries.    If their music styles are the same, you 
will only have to set the music styles once.

To change a business information, you must retrieve the desired business 
record by typing in the business name in the Name text box.    As you 
type in the letters of the name, FastTrack will find the first record which 
matches those letters.    The rest of that business information will be filled 
in on the Edit/Add panel.    If you are not sure about the spelling of the 
business, you can use the PREV and NEXT buttons to look at records 
before or after the current business.



Once the record has been retrieved, you may change any of the 
information.    To make the changes permanent, press SAVE when you are 
done, otherwise no changes will be made to the FastTrack data file.    
Before the record is saved, the checks described above will be performed. 
(Note that pressing NEW, PREV or NEXT will also save the record).

To delete a record, retrieve it as described above, and press the DELETE 
button.    You will be asked if you are sure you want to delete the record.    
Once you answer yes, there is no turning back.    The record is gone.    Be 
careful when deleting records.

To close the panel, press CLOSE.    It is important to note that the actual 
disk file containing your database is not actually updated until you close 
the Edit/Add panel.    If you plan on adding a large number of entries, it 
might be prudent to close this panel occasionally to update the disk file.

Note:    you can stop editing a new business without saving it in the 
database, by pressing DELETE.    (This will not work when editing an 
existing business, as it will actually try to delete the business).



Options Panel

On the options panel, you can tell FastTrack how it should divide the 
states into regions.    By default, FastTrack uses a simple scheme which 
divides the country into the following regions:

Northeast
Mid-Atlantic
Southeast
Midwest
Great Plains
Southwest
Pacific Northwest
West Coast
South Pacific

NACA uses another way to divide the country.    It divides the US into the 
following regions:

New England
East Coast
Southeast
Great Lakes
Illiana
Wisconsin
South Central
Heart of America
Upper Midwest
Far West
Pacific Northwest

You can have FastTrack use either one of these schemes.    Simply select 
Edit | Options... and the Options panel will pop up.    Click on either 
FastTrack or NAA, and press OK.    All of the regions will be redefined 
according to the selected scheme.



Conducting A Search

Conducting searches for information in FastTrack is simple.    All you have 
to do is have a basic understanding of what is going on when you perform
a search.    FastTrack contains a database of thousands of music industry 
names, addresses, phone numbers.    Obviously, you would rarely need all 
of them at once.    For example, if you want to do a mailing to all the 
record companies on the West Coast which specialize in R&B, you would 
want to only pull out the addresses which fit your needs.

A search allows you to narrow down the list of records which will be copied
to the clipboard.    You do this by specifying what types of businesses you 
are interested in:

Business Types - do you want record companies, bands, 
concert promoters, or something else?

Music Types - do you want companies specializing in all types 
of music or only those specializing in certain genres?

Region - do you want companies from all over the country or 
only those in certain regions of the country?

State - within your selected regions, do you want all of the 
states or only some of them?

City - out of your selected Region(s)/State(s), which cities are 
you interested in?

Name - if you only want specific companies in these regions, 
you can specify exactly which ones you want by speicifying
their names

When you start a search, you must specify two things:    the business 
type(s) you are interested in and the music type(s) you are interested in.   
Then if you wish, you can get information on all of the businesses in the 
entire country, or you can narrow things down by specifying Regions, 
States, Cities, or Names.    The last step in any search is to specify exactly 
what information should be copied to the clipboard and what character to 
use as a delimiter between fields. 

For more information, choose one of the following topics:
Specifying Business Type(s)
Specifying Music Type(s)

Specifying How To Search 
Specifying Region(s)
Specifying State(s)
Specifying City(ies)
Specifying Business Name(s)



Specifying What Information To Include 



Specifying How to Search

In conducting a new search, you must specify business type(s) and music 
type(s), but you may elect not to specify regions, states, cities, or names.  
If you do not specify these things, you will get a list of all businesses 
which match your selected business type(s) and music type(s).

After you have specified music type(s), you will be presented with the 
Search By panel, in which you indicate how you want to conduct your 
search.    If you want to search by regions, click on the Region check box.  
If you want to select certain cities in certain states, click on the State 
check box and the City check box.    (In this case, you would not need to 
click on the State check box, but it will make selecting your cities easier, 
since you will only have to look at the cities from the states which you 
select.)

When you have indicated how you want to conduct your search, press the 
NEXT PANEL button to begin.    If you have not checked any boxes on the 
Search By panel, you will go straight to the Include panel.    To go back, 
press the PREV. PANEL button.

For more information, choose one of the following topics:
Specifying Region(s)
Specifying State(s)
Specifying City(ies)
Specifying Business Name(s)

Specifying What Information To Include 



Regions Panel

On the Regions panel, there are two list boxes.    The top one contains all 
of the geographical regions of the US in which there are businesses which 
are of your specified business type(s) and music type(s).    The bottom one
lists all of the regions which you have selected.    Double click on the 
regions in the top list to add them to the selected list.    Double click on 
the regions in the bottom list to remove them from the selected list.    
When you have added all of your desired regions to the selected list, press
the NEXT PANEL button, or press the PREV. PANEL button to go back.

For more information, choose one of the following topics:
Specifying State(s)
Specifying City(ies)
Specifying Business Name(s)

Specifying What Information To Include 



States Panel

On the States panel, there are two list boxes.    The top one contains all of
the states in which there are businesses which are of your specified 
business type(s) and music type(s) (and, if you have specified regions, are
in your regions).    The bottom one lists all of the states which you have 
selected.    Double click on the states in the top list to add them to the 
selected list.    Double click on the states in the bottom list to remove 
them from the selected list.    When you have added all of your desired 
states to the selected list, press the NEXT PANEL button, or press the 
PREV. PANEL button to go back.

For more information, choose one of the following topics:
Specifying City(ies)
Specifying Business Name(s)

Specifying What Information To Include 



Cities Panel

On the Cities panel, there are two list boxes.    The top one contains all of 
the cities in which there are businesses which are of your specified 
business type(s) and music type(s) (and, if you have specified regions or 
states, are in your regions or states).    The bottom one lists all of the cities
which you have selected.    Double click on the cities in the top list to add 
them to the selected list.    Double click on the cities in the bottom list to 
remove them from the selected list.    When you have added all of your 
desired cities to the selected list, press the NEXT PANEL button, or press 
the PREV. PANEL button to go back.

For more information, choose one of the following topics:
Specifying Business Name(s)

Specifying What Information To Include 



Business Names Panel

On the Business Names panel, there are two list boxes.    The top one 
contains the names of all of the businesses which are of your specified 
business type(s) and music type(s) (and, if you have specified regions, 
states, or cities are in your regions, states, or cities).    The bottom one 
lists all of the businesses which you have selected.    Double click on the 
businesses in the top list to add them to the selected list.    Double click on
the businesses in the bottom list to remove them from the selected list.    
When you have added all of your desired businesses to the selected list, 
press the NEXT PANEL button, or press the PREV. PANEL button to go 
back.

For more information, see the following topic:
Specifying What Information To Include 



Business Types Panel

In conducting a new search, you are required to specify business type(s).   
On the Business Types panel, there are two list boxes.    The top one 
contains a list of all business types in the database.    The bottom one 
contains all of the business types which you have selected.    To add a 
business type to the selected list, double click on it in the top list box.    To 
remove a business type from the selected list, double click on it in the 
bottom list box.

When you have selected all of your desired business types, press the 
NEXT PANEL button to select music type(s), or press CANCEL SEARCH 
to abort the search.

For more information, see the following topic:
Specifying What Information To Include 



Music Types Panel

In conducting a new search, you are required to specify music type(s).    
On the Music Types panel, there are sixteen check boxes corresponding 
to sixteen major categories of popular music.    Select or deselect types of 
music by clicking on their check boxes.

To select all music types, press the Select All button.    To deselect all 
music types, press the Deselect All button.

When you have selected all of your desired music types, press the OK 
button to continue.

For more information, see the following topic:
Specifying How To Search 



Include Panel

The Include panel allows you to specify exactly what information you 
want FastTrack to copy into the clipboard for each business which you 
have selected in your search.    You may choose any of the following:

Name - the name of the business
Address - street address, city, state, ZIP code
Phone Number - includes area code
FAX Number - includes area code
Contact Person - if one exists, the name of the contact person

Select or deselect the information by clicking on the five check boxes on 
the Include panel.    Use the combo boxes to the right of each of the first 
four items to specify the character which is to be used as a delimiter.

When you have checked the desired information, press the GO! button.    
FastTrack will now copy the selected information to the clipboard and 
report to you how many recordswere copied to the clipboard.

Your search is now done, and you can paste the information into any 
Windows application to do just about anything!    Remember to save your 
search if you think you may want to reuse it!

For more information, see the following topic:
Save Search



search
A search is the process of selecting businesses from the database by 
specifying the business types, music types, and locations of the desired 
businesses.    At the end of a search, you specify the information you want 
for each business (name, address, phone, etc.).



extension
A filename extension is the three characters of the filename following 
the ..    By default, FastTrack search files have the extension .ftk.



record
A record is all of the information related to a particular business.    This 
includes the following information:

Name Business Type Address City
State Zip Code Phone Number Fax Number
Contact Music Type




